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Preface

Spherekit is a spatial interpolation toolkit that was initiated by Cort Willmott and Mike Goodchild
at the NCGIA.  Development of a ‘user-friendly’ and spherically-based interpolation and mapping
package had been a goal of Willmott’s for some years, which became feasible during his 1995
sabbatical leave at UCSB.  Willmott and Goodchild outlined the desired program structure and
functionality and allocated the necessary funding as part of NCGIA’s Initiative 15: Multiple Roles
of GIS in the U.S. Global Change Program.  Robert Raskin joined the team and expanded upon the
conceptual structure and software design.  Raskin contributed to the development, modification,
and testing of the algorithms and program.  Chris Funk was retained as the primary programmer on
the project, and he ulitmately modified, wrote, integrated and/or tested the wide array of
subprograms and interfaces that now comprise Spherekit.  In the end, Chris contributed much to
Spherekit’s conceptual base, as well as to the programming.  Programs and data also were provided
by Scott Robeson (Indiana University), Scott Webber (University of Delaware), and Robert Renka
(University of North Texas).   Webber additionally contributed to program testing and refinement
during the summer of 1996.  Spherekit relies on GMT (Wessell et al., 1995) for its map and other
graphics, and the authors are grateful to the GMT developers for freely making their programs
available to the scientific community.  Spherekit remains a  work in progress.  Its developers are
continuing to improve it and they welcome feedback from users.
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1. Overview

Spherekit is a spatial interpolation software toolkit developed at NCGIA as part of Initiative 15:
Multiple Roles of GIS in U.S. Global Change Research. This package features several unique
capabilities and is freely distributed over the internet at:

http://whizbang.geog.ucsb.edu/spherekit/

Spherekit allows interpolation over continental or global scales by computing distances and
orientations (among data and interpolation points) from geodesics on the surface of the globe.
Conventional interpolations typically are based upon Euclidean distance in Cartesian 2-space which
involve planar projections that produce distortions of some kind. In Spherekit, projections are
applied only for display purposes after the interpolation has been carried out using spherical
geometry.  Users can select from several interpolation algorithms that have been adapted to the
sphere: inverse distance weighting, thin plate splines, multiquadrics, triangulation, and kriging.
Portions of the GSLIB package have been modified for the sphere and are used in Spherekit to
compute variograms for the kriging algorithms.

Spherekit enables the user to incorporate knowledge or information about the processes that
produce the underlying spatial variations into the interpolation model.  A built-in equation editor
and a collection of nonlinear transforms allow the user to create and experiment with new,
physically meaningful variables from the independent and dependent variables available. This
"smart" interpolation capability allows Spherekit to intelligently interpolate using auxiliary
information. One use of the smart interpolation feature is to incorporate elevation information when
interpolating variables that are correlated with height. A digital elevation model (DEM) is included
with the package for this purpose.

Error analysis is an integrated component of Spherekit making the package particularly useful for
comparing interpolation methods and parameters.  Interpolation method performance is measured
using cross-validation.  Cross-validation error is defined at each observation point as the difference
between its actual value and its interpolated value estimated from the remaining points.  The
resulting error field can be displayed either at the data points or by interpolating to a regular grid to
reduce spatial biases.  Error difference fields, comparing methods or parameter settings, can be
created and displayed with ease.

The Spherekit package has been compiled and tested on SGI and DEC Alpha workstations and
could be ported to other computers running the UNIX operating system.  The software uses Tcl/Tk
for its Graphical User Interface (GUI), Generic Mapping Tools (GMT) for display of output fields,
Ghostview for display of PostScript files, and netCDF for storing the DEM.  All of these required
auxiliary packages can be downloaded together with Spherekit.

This report is a reference guide to the software and is not intended to be read from cover to cover.
Chapter 2 presents four examples of the use of the software.  Chapter 3 takes a single example and
presents the steps required to carry out an interpolation.  Chapter 4 describes each of the menu
options available in Spherekit.  Chapter 5 provides a technical description of the interpolation
algorithms.  Finally, Chapter 6 describes the download and installation procedures.
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2. Examples

2.1 "Smart" interpolation

"Smart" interpolation improves the performance of traditional interpolations by using knowledge of
the processes that produce the spatial variations (Willmott and Matsuura, 1995). In this example we
use the general physical principle that temperature decreases with altitude in the troposphere.  This
decrease can be characterized roughly by the mean lapse rate.  Standard and topographically
informed interpolations are compared using a sparse network of 160 weather stations in China. The
data set is deficient in that high altitude locations in the Himalayan mountains are
underrepresented.

Figure 2.1 shows a standard interpolated temperature field using the multiquadric method.  This
estimate of the temperature field fails to accurately represent the relatively undersampled area of
colder temperatures associated with the greatest elevations.

Figure 2.1 Standard Multiquadric Interpolation (Degrees C)
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Figure 2.2 shows the corresponding topographically informed interpolation (Willmott and
Matsuura, 1995).  This interpolation was performed using the following steps:

  1. Reduce temperatures to sea-level using the mean environmental lapse rate.
     (Sea Level Temp=   Temp   +   Mean Environ Lapse Rate   *   Elevation)

  2. Interpolate the "sea-level" temperature field to a one-degree grid
     using the multiquadric method.

  3. Reintroduce the elevation effect on the interpolated field.
     (Temp=   Sea LevelTemp   -    Mean Environ Lapse Rate   *  Elevation)

     This final step was carried out automatically by Spherekit by
     inverting the operations in Step 1.

Key differences between Figure 2.1 and Figure 2.2 result from the incorporation of the first-order
temperature-elevation relationship (given by the mean environmental lapse rate) into the
interpolator.  That is, the "smart" interpolation captures the climatological influences of
topography.  Low temperatures associated with the mountains of western China are now visible,
despite the sparsity of high altitude temperature stations.

Figure 2.2  Topographically Informed Interpolation (Degrees C)
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2.2 Global interpolation

This example focuses on interpolation over the entire globe. A 2456 station subset of the Global
Historical Climatology Network (GHCN) (Vose et al., 1992) temperature observations for January
1990 were interpolated to a one-degree global grid.   Sparsely populated regions end to be
undersampled, resulting in a station network that is not uniformly distributed around the globe.
Note that the use of spherical surface geometry ensures realistic patterns of isotherms throughout
the polar region (Figure 2.3).

Figure 2.3  Global Interpolation of GHCN Data (Degrees C)

The interpolation method used is inverse distance weighting. Users specify which of several inverse
distance functions to use and how the neighborhood of influence is determined.  A neighborhood
can be defined by a distance (radius) or by a number of points (nearest neighbors).  An
extrapolation correction based upon local gradients of the observed field is available to prevent
local extrema (or peaks or valleys) from occurring only at the data points.  A spatial bias correction
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can be invoked to adjust the distance weights based upon the angular distribution of the nearest
neighbors. The influence of both the extrapolation and spatial bias corrections may be
independently scaled.

The orthographic projection of the interpolated temperature field shown in Figure 2.3 represents a
reimplimentation of Shepard's (1968) interpolator with an average of seven nearest neighbors, a
limited extrapolation capability, and an angular correction.

2.3 Error analysis

Spherekit provides researchers with the ability to quickly and easily compare interpolation methods
and interpolation parameter settings. This example compares two methods: thin-plate spline and
Cressman (an inverse distance weighted method). Figures 2.4 and 2.5 present error analyses of
these methods applied to the Australia portion of the GHCN dataset used in Example 2. Cross
validation is used to generate error estimates at each observation point.  These errors are then
interpolated to a grid, reducing spatial bias. The plots below are gridded, revealing the one-degree
granularity of the interpolation.

Further analyses may be carried out using Spherekit's matrix math capabilities. Figure 2.6 displays
the difference field (Cressman-Spline) of the above error plots. It is interesting to note that the
standard deviation of the difference field is greater than both mean absolute errors.

2.4 Spatial variability

Several exploratory data analysis tools are available to examine the spatial variability of a dataset.
Several of the features of the GSLIB software library are integrated into Spherekit.  The GHCN
temperature dataset of Example 2 is used again to demonstrate the long-distance correlations
present in climate data. As Spherekit computes distances using great circle distances, distances at
continental and global scales are computed correctly.

Figure 2.7 shows an isotropic semivariogram of the dataset. There is a plateau in the semivariogram
in the 2000-4000 km range and a sharp rise thereafter. This calculation is repeated using anisotropic
semivariograms in the east-west and north-south directions. Figure 2.8 (the east-west
semivariogram) displays the plateau more prominently.  This characteristic corresponds to the
common notion that zonal variations in temperature are relatively small.  The north-south
variogram (Figure 2.9) shows a more rapid increase in variance with distance, as would be
expected.  Interestingly, the semivariogram falls after reaching a peak; presumably this is due to a
return to the same latitude zone at these distances.
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MAE       0.593 (Mean absolute error)
MBE      -0.13 (Mean bias error)
RMSE      0.873 (Root mean square error)
MIN      -4.568
MAX       3.173
COUNT 1,248

Figure 2.4  Thin-Plate Spline Cross-validation (Degrees C)
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                            MIN      -4.999
MAX       4.176

   AVG      -0.223
STD       1.410

                                COUNT 1,248

Figure 2.6 Difference field (Spline error - Cressman error) (Degrees C)
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Figure 2.7 Isotropic semivariogram (Degrees C) 2  as a function of distance (km)
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Figure 2.8 North-South semivariogram (Degrees C) 2  as a function of distance (km)

Figure 2.9 North-South semivariogram (Degrees C) 2  as a function of distance (km)
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3. Tutorial

For this tutorial, you will use a dataset consisting of precipitation, elevation, and
temperature values for 160 locations in China. Spherekit can produce a complete
estimated field for these variables using various interpolation techniques.  The package
also can produce a field of error estimates at the estimated points.  We will examine this
process as well as the following interpolation methods: Inverse Distance Weighting,
Kriging, Splines, and Multiquadric interpolation.

Getting The Test Data

Begin by downloading the file china.dat from
www.ncgia.ucsb.edu/pubs/spherekit/main.html.  Move this file to your Spherekit work
directory.  Examine the first few lines of this file by typing: head china.dat. The first
few lines should look like this:

51.716667 126.650000       244.000000     3.0   -27.7
48.766667 121.916667       823.000000     4.0   -23.1
49.216667 119.750000       610.000000     2.0   -29.7
50.500000 121.466667      1067.000000    4.0   -30.0
49.166667 125.233333       305.000000     2.0   -28.6
47.383333 123.916667       152.000000     1.0   -23.3
47.433333 126.966667       244.000000     4.0   -22.9
47.233333 131.983333        91.000000      5.0   -20.3
46.816667 130.283333       122.000000     0.0   -22.7
45.283333 130.950000       152.000000     0.0   -20.2

Running Spherekit

From a command prompt, type 'sk'.  This should bring up the Spherekit application,
depicted below.  If not, consult the README file for guidance.  You should have a
window that looks Figure 3.1. Spherekit allows you to manipulate eight different kinds
of objects. Click on the little graphic icons that line up on the left of the Spherekit
window. Read the messages for each of the eight objects. This should familiarize you
with the Spherekit data types.

Creating a SK Project Directory

Spherekit allows you to organize your work into projects, each project corresponds to a
sub-directory off of your Spherekit work directory.  Create a new work directory by
selecting:

File->Environment->Create New Project
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________________________________________________________________________

Figure 3.1 Main Screen

________________________________________________________________________

That is, select File from the Main Menu, Environment from the File submenu, and
Create New Project from the Environment submenu.  When prompted for a name,
enter 'tutorial' and hit return. tutorial  will now become the current project, and all data
objects will be stored in this directory. If you would like to return to this workspace in a
later session, choose:

File->Environment->Set Project

Next we will create a Location object. Spherekit stores locations independently of sets of
values. This allows multiple sets of values to refer to the same set of locations. To load
(import) a set of locations that are irregularly spaced, choose:
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File->Import Data->Locations->Network

When the dialog box appears:

I. Enter China.net in the first field.

II.  
A. Click on the 2nd field, and use the file dialog to find the 'china.dat' file,

 B. Click OK.

III.  Click Okay again.

This should generate a Network object called China.net that should appear in the
Network section. Click on the object's name 'China.net', and examine its metadata. Every
new object should be examined in this manner.

Now we're ready to read some data values. Go to:

File->Import Data->Values

Set the name field to 'Temperature'. Click on the ?????? in the locations field. ?????? is
Spherekit's generic symbol for 'need this value'. Select china.net from the drop down
menu. If the 'china.dat' file is not specified, select that file. Then click OK.

This should generate an Observations object called temperature. Click on Temperature
and examine the metavalues.

Two “objects" should now be in the interface window. One is named "Temperature"
which is a temperature dataset for 160 weather stations in China. The second is called
"China.net" which is the latitude and longitude of the nodes of the weather station
network.

Generating a Temperature Plot

Now we will create a dot map of the temperature field. Click:

Display->Field

This opens a dialog box that looks like Figure 3.2.
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Figure 3.2 Display Field Dialog Box

Under the Display Field heading click on the ??????
and select Temperature. Under the Projection heading
Pick an appropriate projection for China. You may
have to experiment with this parameter until you get a
projection you think is good. Click OK when you have
selected the display field and the projection. You
should get a map of the Temperature data points for
China that will look similar to the Figure 3.3.

This is the data from which you will be generating
interpolated fields of Temperature. At this point you
must create an interpolation method and a grid .
Creating an interpolation method involves selecting
one of several predefined methods, such as inverse
distance, and specifying some parameters, such as the
spatial extent of the data included in the estimation.
For example, if we are interpolating temperature in the
continental United States how many points do we want
to use to interpolate a temperature value in Tucumcari
New Mexico?  Should we use data from Seattle?  This
problem is called the "Neighbor Selection problem",
and the user provides parameters to identify the
neighborhood size.  Another parameter to be set is the
exponent of the inverse distance weighting. The default
exponent is 2.0 (in analogy to the effect of gravity), but
you may experiment with the value of this parameter.

.
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Figure 3.3 Display of original (pre-interpolated) data

This figure shows a set of 160 weather stations from the Geophysical Historical Climate
Network, for the month of December.
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Creating an Interpolation Method

To create your interpolation method, select:

Interpolation->Create Method->Inverse Distance Weighting

This should produce a dialog box that looks like Figure 3.4.

The “Range Modes” identifies how the
neighborhood size is specified.  It is described
in detail in Section 5.1.  For now, use the
default settings, which will select a
neighborhood size of between 4 and 10 points,
depending on the density of data in the vicinity
of the interpolation point.

The “Function Definition” specifies the nature
of the mathematical inverse distance function
(see Section 5.1 for details). These defaults are
fine. Click OK to accept them. This creates a
new method called Shep1 that should appear in
the Spherekit window.

Figure 3.4 Define Method Dialog Box
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Creating an Interpolation Grid

In Spherekit a grid is simply a set of locations arranged at a regular distance (in degrees)
from one another. To create a grid, select:

Interpolate->Create Grid

You should see the Grid Definition Dialog Box as shown in Figure 3.4.

Figure 3.5 Define Method Dialog Box

You could play with these parameters, i.e. the resolution of the grid, the extent of area
that you want to interpolate to, etc. For this example just accept the defaults by clicking
OK. This will create an object called Grd1 that will show up in the Spherekit window.
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Performing an Interpolation

Now we are ready to perform an interpolation. This will estimate a value at each of the
cells in the grid you have just defined. To do this choose the following:

Interpolation->Begin Interpolation

This produces, you guessed it: yet another dialog box that looks like Figure 3.6.

Figure 3.6 Interpolation Dialog Box

Fill in this dialog as follows:

I. Choose a name that makes sense for the output field name. e.g. TempInvDist

II.  Click on all the fields with ?????? in them and choose the appropriate objects.

III.  Then click "OK". This will produce a new object with the output field name you supplied.

After interpolation occurs, the display dialog box will appear. Select a Display Field that
is the interpolated field object that you just created (It should be the default), Select a
Graph Type that appeals to you (fool around here, grid plots and Isolines are different).
Grid plots simply provide the value of the grid cell, while a contour plot smooths the
image based on a Delaunay triangulation procedure.

Now choose the Options that appeal to you.  We suggest “Superimpose Data Values”,
and “Base Scale on Source. Then click OK. An image will appear. This can be printed if
you like, by selecting print from the ghostview file menu.

Generating Error Fields

Spherekit contains a rather limited set of online help topics. Begin this section by
selecting:

Display->Help

This will bring up a list of the available help topics. Select Cross-Validation-At-Net and
read the help message. Repeat this for Cross-Validation-At-Grid .

To make an image of the estimated error field select the following:

Cross-Validation at Grid
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Complete these steps to fill in the field:

I. Enter a meaningful (but conscise!) name for this error field.

II.  In the interpolation  menu heading select one of your interpolation methods.

III.  In the interpolate from menu select Temperature.

IV.  In the error interpolation method select Shep1.

V. In the interpolate errors to field select the same grid you created earlier (probably Grd1).

VI.  Click OK.

When the display dialog window shows up just click OK. This should bring up a
ghostview representation of the estimated error.
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4. Users’ guide

This section describes screen displays and menu options that you will encounter
when using the package.  When starting Spherekit, the display is divided into eight
types of variables: Observation, Grid, Network, Method, Error, Display,
Interpolation, and Derived variables.  These areas will be filled in with file names
as fields of these types are read in or created.  Clicking on any field name displays
all known metadata for that field.

Throughout a Spherekit session, windows will pop out as options are selected.
The method of closing windows will vary depending on the version of X-
Windows that you are running.  Generally, an icon in the upper left corner can be
clicked to close or exit from the window.

The main screen of Spherekit is shown in Figure 4.1.  Six main menu options
appear along the upper periphery of the screen.  Each of these options contains
suboptions that are described in this section.  The default Project Name: “Work”
also appears on the upper right corner of the screen.

.

Figure 4.1 Main screen
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As files are entered or created by the user, the filenames appear as shown in Figure
4.2.  Clicking on any of the file names displays metadata associated with that file.
The Figure shows a session with the Project Name: “NAM”.  Seven data files
(denoted “Observations”) have been loaded; two Grids and six Networks have
been defined.  These Grids and Networks may represent locations being
interpolated from or interpolated to.  One interpolation Method has been created.
Four have been created in the example.  The example also shows that two
Interpolations and one Derived variable have been defined.  The Interpolation files
contain a description of the combination of Observations, a Grid or Network, and
Method used to define the interpolation.  The resulting output files appear as
Display files with a default suffix of .map.  The Display files can be converted to
and saved as PostScript files.  A Derived variable contains the output of a
mathematical formula or function.

.

Figure 4.2  Main screen during sample session

In the remainder of this chapter, the menu options are explained; bold face is used
to denote a specific menu item.  The six major subheadings in this chapter directly
correspond to the six main menu options in Spherekit.  The submenu selections
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from the main menu appear below with an arrow symbol ⇒ for each level below
the main menu.

File

⇒Environment

⇒⇒Set Project Directory
This option allows the user to return to a working environment that was left at an
earlier time.   Upon return, all variables are reloaded and the status of the program
is restored.  To use this option, the user is prompted for the names of all saved
projects.

⇒⇒Create Project Directory
This option creates a new workspace into which a user can load data.  Upon
return, all variables are reloaded and the status of the program is restored.  To use
this option, the user is prompted to enter a name of the current project.  The initial
project directory has the default name: Work.

⇒⇒Delete Project Directory
This option deletes a previously created working environment.  The user is
prompted for the name of an existing project environment.

⇒Import Data
Use this selection to load your data and/or the built-in DEM into Spherekit. These
features are described below.

⇒⇒Locations
A set of locations is classified either as a network (irregularly spaced) or a grid
(regularly spaced). 

⇒⇒⇒Network (irregularly spaced points)
If you select Network, you are prompted for the column numbers of the latitudes
and longitudes in the input file. You also are prompted for the file name and the
format of the file (binary or ASCII). For ASCII files, you can enter a delimiter
other than a blank space.  A final option is available to read in a location index for
each location. This allows the observation values to be referenced by location
number. To use this option, you are prompted for the column number of the index
in the location file.

⇒⇒⇒ Grid (regularly spaced points)
If you select Grid, you are prompted for the starting location and the grid
resolution in east-west and north-south directions, either in km or degrees.  You
are asked for a name to assign to the grid, so that it can be referenced later.
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⇒⇒Values
To load the data values associated with the grid or network that you've defined,
enter the file name where they may be found and the column number.  You are
also asked for the associated grid or network name. If an indexed location is
associated with each observation, select that option and enter the column number
for the location index.

⇒⇒DEM
A digital elevation model (DEM) is built into Spherekit.  Its coverage is global,
including elevations both above and below sea level.  To access the DEM, enter
the name of the grid or network on which elevation values are desired.  Assign a
file name to the created values and use the data set as any other observational data
set.

⇒Export Data
To save a field, enter the field name, the desired file format (ASCII or native
binary), and the desired file name.

⇒Delete Variable
Spherekit saves all created objects in external files.  Any of the following can be
deleted with this selection: observation file, grid or network description,
interpolated field, error field, or postscript display.

⇒Quit
Exits Spherekit and returns to the operating system.

Processing

⇒Derived variable
A wide range of mathematical transforms can be applied using this option.  The
selected operation is applied to all elements of the data set. The dataset may be
observations, an interpolated surface, cross-validation errors, or a previously
transformed variable.

⇒⇒Linear transform
Change the units or rescale the data by specifying a constant (offset) and slope
(scale factor).

⇒⇒Nonlinear transform
This option can be used to reduce the skewness or kurtosis in the data. The inverse
transform is applied automatically following interpolation as a default. This
inverse operation can be disabled if desired when the Begin Interpolation option is
selected. The available nonlinear transforms are:










































